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Important Information

Warranty
The RT Series DAQ hardware is warranted against defects in materials and workmanship for a period of one year from the date
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment
that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions,
due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other
documentation. National Instruments will, at its option, repair or replace software media that do not execute programming
instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not
warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult
National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of
or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY

WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR

NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL

INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR

CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will
apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments
must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects,
malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or
surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including
photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written
consent of National Instruments Corporation.

Trademarks
LabVIEW™, MITE™, National Instruments™, ni.com™, NI-DAQ™, PXI™, RTSI™, and SCXI™ are trademarks of
National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNEDWITH COMPONENTS AND TESTING FOR A LEVEL
OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL
COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANYAPPLICATION, INCLUDING THEABOVE, RELIABILITYOFOPERATIONOF THE SOFTWARE PRODUCTS
CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL
POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE
FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION,
INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR
FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC
SYSTEMS (HARDWAREAND/OR SOFTWARE), UNANTICIPATED USES ORMISUSES, OR ERRORS ON THE PART OF
THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH)
SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE
REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO
BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS
FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER
MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATIONWITH OTHER PRODUCTS IN AMANNER NOT
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS
ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A
SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND
SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Compliance

FCC/Canada Radio Frequency Interference Compliance*

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference.
The FCC places digital electronics into two classes. These classes are known as Class A (for use in industrial-
commercial locations only) or Class B (for use in residential or commercial locations). Depending on where it is
operated, this product could be subject to restrictions in the FCC rules. (In Canada, the Department of
Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.)

Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless
products. By examining the product you purchased, you can determine the FCC Class and therefore which of the two
FCC/DOC Warnings apply in the following sections. (Some products may not be labelled at all for FCC, if so the
reader should then assume these are Class A devices.)

FCCClass A products only display a simple warning statement of one paragraph in length regarding interference and
undesired operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations
where FCC Class A products can be operated.

FCC Class B products display either a FCC ID code, starting with the letters EXN,
or the FCC Class B compliance mark that appears as shown here on the right.

The curious reader can consult the FCC web site http://www.fcc.gov for more
information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the
instructions in this manual and the CE Mark Declaration of Conformity**, may cause interference to radio and
television reception. Classification requirements are the same for the Federal Communications Commission (FCC)
and the Canadian Department of Communications (DOC).

Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate
the equipment under the FCC Rules.

Class A
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du
Canada.

Class B
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful



interference to radio or television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du
Canada.

European Union - Compliance to EEC Directives
Readers in the EU/EEC/EEA must refer to the Manufacturer's Declaration of Conformity (DoC) for information**
pertaining to the CE Mark compliance scheme. The Manufacturer includes a DoC for most every hardware product
except for those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or
where compliance is not required as for electrically benign apparatus or cables.

* Certain exemptions may apply in the USA, see FCC Rules §15.103 Exempted devices, and §15.105(c). Also
available in sections of CFR 47.

** The CE Mark Declaration of Conformity will contain important supplementary information and instructions for
the user or installer.
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About This Manual

This manual contains information about the RT Series Data Acquisition

(DAQ) devices and working with LabVIEW Real-Time (RT). The RT

Series DAQ hardware consists of the following devices:

• PCI-7030/6040E

• PCI-7030/6030E

• PCI-7030/6533

• PXI-7030/6040E

• PXI-7030/6030E

• PXI-7030/6533

The RT Series DAQ family of devices are multifunction I/O boards with an

embedded processor. Use LabVIEW RT and NI-DAQ to create embedded,

real-time applications that run on the RT Series DAQ device.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to

pull down the File menu, select the Page Setup item, and select Options

from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

bold Bold text denotes items that you must select or click on in the software,

such as menu items and dialog box options. Bold text also denotes

parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction

to a key concept. This font also denotes text that is a placeholder for a word

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the

keyboard, sections of code, programming examples, and syntax examples.

This font is also used for the proper names of disk drives, paths, directories,
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programs, subprograms, subroutines, device names, functions, operations,

variables, filenames and extensions, and code excerpts.

Related Documentation

The following documents contain information that you might find helpful

as you read this manual:

• LabVIEW Real-Time User Manual

• LabVIEW Real-Time Release Notes

• LabVIEW Real-Time Help, available by selecting Help»LabVIEW

Real-Time Help

• Getting Started with LabVIEW

• LabVIEW User Manual

• LabVIEW Measurements Manual

• LabVIEW Help, available by selecting Help»Contents and Index

• LabVIEW Application Builder Release Notes

• PID Control for G Reference Manual

Refer to the hardware user manual for the specific I/O device attached to

your RT Series device for more information about the I/O portion of your

hardware. For example, if you are using the PXI-7030/6040E, refer to the

PXI E Series User Manual for information on the 6040E daughterboard.
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1
Introduction

This chapter describes the RT Series DAQ devices, lists what you need

to get started, explains how to unpack your RT Series DAQ device, and

describes the software you need to use.

About the RT Series

The RT Series DAQ devices are multifunction DAQ devices with an

embedded processor. The RT Series DAQ device, LabVIEW Real-Time

(RT), and NI-DAQ provide an easy-to-use system for real-time

applications.

Each RT Series DAQ device is made up of the following parts: a processor

board and a DAQ daughterboard. The processor board contains a

microprocessor that runs real-time, embedded LabVIEW RT applications.

The RT Series DAQ device provides the same high-performance data

acquisition as other National Instruments DAQ devices. For example,

the PXI-7030/6040E contains a DAQ device that is equivalent to the

PXI-6040E.

This manual does not contain detailed information about the DAQ

component of the RT Series DAQ devices. Refer to the appropriate DAQ

hardware user manual for more information about optional equipment and

custom cabling for your DAQ device. Table 1-1 lists the appropriate DAQ

device user manual for each of the RT Series DAQ devices.
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What You Need to Get Started

To set up and use your RT Series DAQ device, you need the following:

❑ One of the following devices:

– PXI-7030/6XXX

– PCI-7030/6XXX

❑ This manual

❑ Hardware user manual for your DAQ daughterboard,

shown in Table 1-1

❑ LabVIEW RT

❑ LabVIEW Real-Time User Manual

❑ LabVIEW Real-Time Release Notes

❑ NI-DAQ and the NI-DAQ documentation installed with the software

❑ Your computer

Table 1-1. RT Series DAQ Device and Corresponding DAQ Device Manual

RT Series DAQ Device DAQ Manual

PXI-7030/6040E PXI E Series User Manual

PXI-7030/6030E PXI E Series User Manual

PXI-7030/6533 DIO 6533 User Manual

PCI-7030/6040E PCI E Series User Manual

PCI-7030/6030E PCI E Series User Manual

PCI-7030/6533 DIO 6533 User Manual
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Unpacking

Your RT Series DAQ device is shipped in an antistatic package to prevent

electrostatic damage to the device. Electrostatic discharge can damage

several components on the device. To avoid such damage in handling the

device, take the following precautions:

• Ground yourself by using a grounding strap or by holding a grounded

object.

• Touch the antistatic package to a metal part of your computer chassis

before removing the device from the package.

• Remove the device from the package and inspect the device for

loose components or any other sign of damage. Notify National

Instruments if the device appears damaged in any way. Do not install

a damaged device into your computer.

• Never touch the exposed pins of connectors.

Software Programming Choices

Use the RT Series DAQ devices with LabVIEWRT and NI-DAQ. Because

NI-DAQ is included with LabVIEW RT, install NI-DAQ during the

LabVIEWRT installation. Refer to the LabVIEWReal-Time Release Notes

for specific information about LabVIEW RT and NI-DAQ version

compatibility. Refer to Chapter 2, Installation and Configuration,

for information about installing your RT Series hardware.
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2
Installation and Configuration

This chapter explains how to install and configure your RT Series DAQ

hardware.

Installing the Hardware

You can install the RT Series DAQ device in any available expansion slot

in your computer or PXI chassis. To reduce noise, however, leave as much

room as possible between the RT Series DAQ device and other devices and

hardware. The following are general installation instructions. Refer to your

computer user manual or technical reference manual for specific

instructions and warnings about installing hardware.

Note Install LabVIEW Real-Time (RT) and NI-DAQ before you install your RT Series

DAQ device. Refer to Chapter 2, Installation, of the LabVIEW Real-Time User Manual for

information about installing LabVIEW RT and NI-DAQ.

PCI Installation
Complete the following steps to install your RT Series PCI device.

1. Turn off and unplug your computer.

2. Remove the cover to your computer.

3. Make sure there are no lighted LEDs on your motherboard. If any are

lit, wait until they go out before continuing your installation.

4. Remove the expansion slot cover on the back panel of the computer.

5. Insert the RT Series DAQ board into a 5 V PCI slot. Gently rock the

board to ease it into place. It might be a tight fit, but do not force the

board into place.

6. Screw the mounting bracket of the RT Series DAQ board to the back

panel rail of the computer.

7. Visually verify the installation. Make sure the board is not touching

other boards or components and is fully inserted in the slot.

8. Replace the cover.

9. Plug in and turn on your computer.
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Your RT Series DAQ device is installed. You are now ready to configure

your software.

PXI Installation
Complete the following steps to install your RT Series PXI board.

1. Turn off and unplug your computer.

2. Choose two adjacent unused PXI slots in your system.

3. Remove the filler panels for the slots you have chosen.

4. Insert the RT Series DAQ board into the 5 V PXI slots. Use the

injector/ejector handle to fully insert the board into the chassis.

5. Screw the front panel of the RT Series DAQ board to the front panel

mounting rail of the system.

6. Plug in and turn on your computer.

Your RT Series DAQ device is installed. You are now ready to configure

your software.

Board Configuration

Because of the National Instruments standard architecture for data

acquisition and the PCI and PXI bus specifications, the RT Series DAQ

devices are completely software configurable.

The PCI RT Series DAQ devices are fully compatible with the industry

standard PCI Local Bus Specification Revision 2.0. The PXI RT Series

DAQ devices are fully compatible with the PXI Specification Revision 1.0.

This compatibility allows the PCI or PXI system to automatically perform

all bus-related configurations and requires no user interaction.

DAQ-related configuration includes such settings as analog input polarity

and range, analog input mode, and so on. You also can configure virtual

channels, SCXI, and DAQ accessories. You can modify these settings

through Measurement & Automation Explorer (MAX) or through

LabVIEW RT and NI-DAQ.

After you install your RT Series DAQ device, double-click the

Measurement & Automation Explorer icon on your desktop. MAX finds

the RT Series DAQ device and any other DAQ devices you have in your

system and assigns device numbers to them. The RT Series DAQ device

appears in MAX as shown in Figure 2-1.
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Figure 2-1. Measurement & Automation Explorer

Notice that MAX assigns separate device numbers to the PCI/PXI-7030

device and the DAQ daughterboard, as shown in Figure 2-1. The DAQ

daughterboard is shown as a separate device under the 7030 processor

board. However, the daughterboard has a device number that is different

from the 7030 processor board.

You need the device numbers of your RT Series DAQ hardware to

download and run LabVIEW RT VIs to your RT Series DAQ devices.You

can change device numbers and other configuration settings for the devices

using MAX. Changes to these settings do not take effect on the RT Series

DAQ device until you reset the device.

You can test the resources of the 7030 processor board using MAX.

However, you cannot test resources or run test panels for the DAQ

daughterboard. Even though the daughterboard is configured using the host

PC, the daughterboard is actually located on the local PCI bus of the RT

Series processor board. Therefore, only LabVIEWRT applications targeted

to the 7030 processor board can access the DAQ daughterboard, and the

resource configuration of the daughterboard cannot be tested from the host

PC. You do not need to test the resource configuration, because National

Instruments configures the DAQ daughterboard, and the resources do not

change. In addition, applications run on the host PC cannot access the DAQ
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daughterboard directly, even though the DAQ daughterboard is configured

as a separate device. Only LabVIEW RT applications targeted to the

RT Series DAQ device can access the DAQ daughterboard.

Tip If you want to test whether the DAQ daughterboard is working, run any DAQ example

that ships with LabVIEW RT.

To save the configuration information, select Tools»NI-DAQ

Configuration»Save Configuration As. Then close MAX.
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3
Hardware Overview

This chapter describes the PCI and PXI RT Series DAQ hardware. You can

find most of the hardware information you need in your DAQ device user

manual. Table 1-1, RT Series DAQ Device and Corresponding DAQ

Device Manual, lists the DAQ device user manuals for the RT Series DAQ

devices.

As shown in Figures 3-1 and 3-2, a DAQ daughterboard attaches to the

processor board, and together they form the RT Series DAQ hardware. The

following sections describe the components that make up the RT Series

DAQ hardware.

Figure 3-1. PCI RT Series Data Acquisition Hardware

1 Processor Board 2 DAQ Daughterboard

1

2
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Figure 3-2. PXI RT Series Data Acquisition Hardware

Processor Board

The 7030 processor board contains a microprocessor and support circuitry,

as shown in Figure 3-3. The support circuitry includes a chipset with PCI

controller and ISA bridge, main memory (DRAM), L2 cache (SRAM), and

BIOS. The RT Engine software uses this embedded processor system for

its execution platform.

The DAQ daughterboard resides on the embedded PCI bus, as shown in

Figure 3-3, providing a high-performance system for communication

between the software running on the processor and the DAQ

daughterboard.

The processor board also holds the shared memory that communicates

between the host system and the embedded processor. Refer to the Host to

RT Series DAQ Device Communication section of this chapter and to

Chapter 3, Software Overview, of the LabVIEW Real-Time User Manual,

for more information about using shared memory in your applications.

1 Processor Board 2 DAQ Daughterboard

1

2
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Figure 3-3. RT Series Processor Board Diagram
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DAQ Daughterboard

The daughterboard in the RT Series system provides the DAQ

functionality. Each daughterboard is a National Instruments DAQ device

with some mechanical modifications to allow it to connect to the processor

board. You can expect the same high performance and specifications from

the daughterboard that you do from the standard version of the device.

For example, the PCI/PXI-7030/6040E boards have the same DAQ

characteristics as the PXI-6040E. Refer to the appropriate daughterboard

manual for specifications, cabling requirements, and accessory

information. Table 1-1, RT Series DAQ Device and Corresponding DAQ

Device Manual, lists the corresponding manual for each available

daughterboard. Refer to the DAQ section of the LabVIEW Help, available

by selecting Help»Contents and Index in LabVIEW, for more

information about hardware and software configuration.

Host to RT Series DAQ Device Communication

The computer where you install the RT Series DAQ device is the host

computer. The RT Series DAQ device communicates to the host computer

where it resides through shared memory on the 7030 processor board. Both

the host computer and the embedded processor have access to the shared

memory. The memory is allocated for various tasks. For example, the RT

Development System on the host uses part of the shared memory for

downloading software to the device. Some memory space also is allocated

to the user for passing data between the host computer and the processor

board.

RTSI

The real-time system integration (RTSI) bus directly connects DAQ

devices for precise synchronization of functions. The RT Series DAQ

devices provide all RTSI functionality. The RTSI bus allows you to

connect RT Series DAQ devices to any other DAQ device regardless of

whether the other device is an RT Series device or standard DAQ device.

The RTSI connections are made across the PXI trigger bus for the PXI RT

Series devices. For PCI RT Series devices, the connection is made with a

connector on the top edge of the device and a RTSI cable available from

National Instruments. Refer to your daughterboard user manual for
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information about how to use the RTSI signals. Table 1-1, RT Series DAQ

Device and Corresponding DAQ Device Manual, lists the corresponding

manual for each available daughterboard.

LEDs

The RT Series processor board has two LEDs. You can use these LEDs to

indicate the state of your running application. On the PXI-7030 device, the

LEDs are visible on the front panel. Because the LEDs are located along

the top edge of the device on the PCI-7030, you must remove the cover

from the case of your computer to view them.

The red LED turns on during a portion of the reset of the RT Series DAQ

device. Also, the red LED turns on and remains lit if the RT Engine detects

an internal error. You can control both the red LED and a second green LED

from LabVIEW RT applications to provide status information.

You can use the RT Board LEDs VI located on the Functions»RT»RT

Series DAQ»RTBoardUtilities palette in your application to control each

LED independently. You can turn each LED on, off, or toggle its state.

Refer to the LabVIEW Real-Time Help, available by selecting

Help»LabVIEW»Real-Time Help, for more information about the RT

Board LEDs VI.
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4
LabVIEW RT Programming

This chapter provides an overview of using LabVIEWReal-Time (RT) and

your RT Series DAQ hardware.

Targeting LabVIEW RT and Downloading VIs

In LabVIEW RT, selectOperate»Switch Execution Target to access the

Select Target Platform dialog box, shown in Figure 4-1.

Figure 4-1. Select Target Platform Dialog Box

Use the pull-down menu to select where you want to run VIs. When you

select a target platform, the RT Development System downloads any

VI you subsequently run to that target platform. Selecting Host PC

(LabVIEW for Windows) makes LabVIEW RT behave like LabVIEW

for Windows on the host PC.

Any RT Series DAQ device that you configure with Measurement &

Automation Explorer (MAX) appears in the pull-down menu. The menu

selection for each device displays the device number, for example,

DAQ::1, where 1 is the device number. Click the Reset device checkbox

in the Select Target Platform dialog box to reset the RT Series DAQ

device. Any VIs you previously downloaded to the RT Series DAQ device

are aborted and unloaded from memory. Click Configure in the
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Select Target Platform dialog box to launchMAX and configure your RT

Series DAQ devices.

Resetting the RT Series DAQ Device
Resetting the RT Series DAQ device is necessary only after you first turn

on the system or if communication with the RT Engine cannot be

established or has been lost. Also, reset the device when you change the

DAQ configuration information for the RT Series DAQ device.

Creating Stand-Alone Executables

Use the Application Builder, included in the LabVIEW RT Professional

Development System, to create stand-alone LabVIEW RT applications.

Refer to the LabVIEW Real-Time User Manual and the LabVIEW

Application Builder Release Notes for more information about the

Application Builder.

Note If you have the LabVIEW RT Full Development System, you can purchase the

Application Builder upgrade.

Embedded Applications
Because the RT Series DAQ hardware has no media storage device, you

cannot permanently embed applications on the hardware. You must launch

applications on the host and target them to the RT Series DAQ device.

Command-Line Arguments
You can use command-line arguments to disable the Select Target

Platform dialog box and explicitly specify a target for the application. You

can use the parameters in a batch file, or shortcut, from your Windows

StartUp folder to automatically launch RT Engine VIs when your host PC

is booted. For example, create a Windows shortcut with the following

shortcut target:

c:\mybuiltapp.exe -target DAQ::1 -quithost

This command line automatically downloads and runs mybuiltapp on

device 1 and closes the RT Development System on the host PC.
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To disable the Select Target Platform dialog box, specify the target

platform in the command line argument of your built executable using

–target. For example,

c:\mybuiltapp_rtengine.exe -target DAQ::3 (for device 3)

or to run the application on the host PC,

c:\mybuiltapp_host.exe -target host

You also can reset the specified device using -reset. For example,

c:\mybuiltapp_rtengine.exe -target DAQ::3 -reset

To disconnect the host PC from the RT Engine after all VIs are downloaded

and leave the RT Engine VIs running, use -quithost. For example,

c:\mybuiltapp_rtengine.exe -target DAQ::3 -quithost

Programming LabVIEW RT

Because you run LabVIEWRT applications on hardware platforms that do

not have all the components of a computer, LabVIEW RT lacks some

LabVIEW features when targeted to the RT Engine. For example, there is

no disk drive on the RT Series DAQ device, therefore, the RT Engine does

not support file I/O when targeted to the RT Series DAQ device. The RT

Engine does not support the following LabVIEW features on RT Series

DAQ hardware:

• ActiveX

• Datalogging

• Dialog boxes

• Ethernet

• File I/O

• Instrument I/O: VISA, 488, RS-232/Serial

• Printing

• Profiler

• Programmatic Menu Bar

Note If you attempt to download to and run on your target platform a VI that has any of

the unsupported functionality listed above, the VI still executes. Unsupported functions do

not work and return standard LabVIEW error codes.
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Real-Time Programming

This section provides an overview of real-time programming using your

RT Series DAQ hardware.

Running a VI at Time-Critical Priority without
the RT Development System

Instead of using TCP/IP or VI Server to communicate data to a host PC

application, you can maximize real-time VI performance on RT Series

DAQ devices by peeking and poking data to shared memory. Peeking, or

reading directly from shared memory, and poking, or writing directly to

shared memory, are common programming techniques and do not require

the VI to yield significant processor time. You can create deterministic

control loops that run in excess of 1 kHz when you peek and poke data

to shared memory. Refer to Chapter 3, Software Overview, of the

LabVIEW Real-Time UserManual for more information about TCP/IP and

VI Server.

Note Windows NT does not support peeking and poking to shared memory on the PC.

However, because the shared memory is located on the RT Series DAQ device, Windows

NT does support peeking and poking to this shared memory.

Use of Shared Memory
Using peek and poke VIs to write directly to shared memory offers the best

performance. Because you can access shared memory both from a host

LabVIEW application and from an embedded LabVIEW RT VI, you can

write a control loop program that does not have to slow down significantly

or yield to communicate with the host system. Many such examples are in

the examples\RT\RT Control (7030).llb library.

Configuration Issues
The RT Development System downloads the RT Engine to the RT Series

DAQ hardware and sends configuration information when you reset the

hardware. If you make any change to the device configuration information

from MAX, you must reset the RT Series DAQ hardware for the changes

to take effect.

LabVIEW RT also supports virtual channels, SCXI, and DAQ accessories

on the RT Series DAQ hardware, but their descriptions download to the

device when the device is reset. If you add a new channel or change the

parameters of a channel using MAX, you must reset the RT Series DAQ
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hardware for these changes to take effect. However, unlike virtual

channels, you can set device parameters or accessory configuration

information programmatically inside a VI without running MAX.

Therefore, you can programmatically change these parameters in your VI

without resetting the hardware.

Refer to your NI-DAQ documentation and the DAQ section of the

LabVIEW Help, available by selecting Help»Contents and Index,

for more information about configuration.

RT Series DAQ VIs

RT Series DAQ VIs are available on the Functions»RT»RT Series DAQ

palette. Refer to the LabVIEW Real-Time Help, available by selecting

Help»LabVIEW Real-Time Help, for more information about the

LabVIEW RT VIs.

In addition to the RT Series DAQ VIs, LabVIEW RT includes the PID

Control Toolset, which includes functions for PID and Fuzzy Logic control.

The Fuzzy Controller VI requires information for a specific designed fuzzy

controller loaded from its corresponding data file (*.fc). Because the RT

Engine does not support file I/O, you must save this information as the

default values of the front panel controls of the Fuzzy Controller VI before

attempting to use it on the RT Series DAQ device. Refer to the PID Control

for G Reference Manual for more information about the PID Control and

Fuzzy Logic VIs.
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A
Specifications

This appendix lists the specifications of the embedded processor system.

Processor
Processor ................................................ AMD 486 DX5

32-bit architecture

Processor clock speed ............................ 133 MHz

CPU bus speed ....................................... 33 MHz

Memory.................................................. 8 MB DRAM user-programmable

60 ns, EDO, 5 V,

72-Pin SODIMM

On-chip cache ........................................ 16 KB write-back

L2 cache ................................................. 256 KB write-back

Floating-point unit.................................. Yes

Host-Embedded Communication

Shared Memory
Type ....................................................... SRAM

Size......................................................... 1 KB user available

Bus Interface
Type ....................................................... PCI Slave
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Power Requirement
PCI-7030 only

(without daughterboard) .........................1.9 A at +5 VDC (±5%)

PXI-7030 only

(without daughterboard) .........................2.0 A at +5 VDC (±5%)

Note To calculate the total power requirement, add the processor board requirement from

this section to the I/O board requirement given in the I/O board manual.

Physical

Dimensions (Not Including Connectors)
PCI-7030.................................................312.9 by 160.5 cm

(12.3 by 4.2 in.)

One PCI slot

PXI-7030 ................................................16 by 10 cm

(6.3 by 3.9 in.)

Two PXI slots

Environment
Operating temperature ............................0 to 55 °C

Storage temperature ................................–20 to 70 °C

Relative humidity ...................................10% to 90% noncondensing

RTSI
Refer to the RTSI section of Chapter 3, Hardware Overview for

information about real-time system integration.

I/O Daughterboard Specifications
Refer to the appropriate I/O device manual, listed in Table 1-1, RT Series

DAQ Device and Corresponding DAQ Device Manual, for more

information about I/O daughterboard specifications.
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B
Technical Support Resources

Web Support

National Instruments Web support is your first stop for help in solving

installation, configuration, and application problems and questions. Online

problem-solving and diagnostic resources include frequently asked

questions, knowledge bases, product-specific troubleshooting wizards,

manuals, drivers, software updates, and more. Web support is available

through the Technical Support section of ni.com

NI Developer Zone

The NI Developer Zone at ni.com/zone is the essential resource for

building measurement and automation systems. At the NI Developer Zone,

you can easily access the latest example programs, system configurators,

tutorials, technical news, as well as a community of developers ready to

share their own techniques.

Customer Education

National Instruments provides a number of alternatives to satisfy your

training needs, from self-paced tutorials, videos, and interactive CDs to

instructor-led hands-on courses at locations around the world. Visit the

Customer Education section of ni.com for online course schedules,

syllabi, training centers, and class registration.

System Integration

If you have time constraints, limited in-house technical resources, or other

dilemmas, you may prefer to employ consulting or system integration

services. You can rely on the expertise available through our worldwide

network of Alliance Program members. To find out more about our

Alliance system integration solutions, visit the System Integration section

of ni.com
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Worldwide Support

National Instruments has offices located around the world to help address

your support needs. You can access our branch office Web sites from the

Worldwide Offices section of ni.com. Branch office Web sites provide

up-to-date contact information, support phone numbers, e-mail addresses,

and current events.

If you have searched the technical support resources on our Web site and

still cannot find the answers you need, contact your local office or National

Instruments corporate. Phone numbers for our worldwide offices are listed

at the front of this manual.
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Glossary

B

BIOS basic input/output system—BIOS functions are the fundamental level

of any PC or compatible computer. BIOS functions embody the basic

operations needed for successful use of the computer hardware resources.

bus the group of conductors that interconnect individual circuitry in a computer.

Typically, a bus is the expansion vehicle to which I/O or other devices are

connected. Examples of PC buses are the ISA and PCI bus.

C

cache high-speed processor memory that buffers commonly used instructions or

data to increase processing throughput

channel Pin or wire lead to which you apply or from which you read the analog or

digital signal. Analog signals can be single-ended or differential. For digital

signals, you group channels to form ports. Ports usually consist of either

four or eight digital channels.

D

DAQ data acquisition—(1) collecting and measuring electrical signals from

sensors, transducers, and test probes or fixtures and inputting them to a

computer for processing; (2) collecting and measuring the same kinds of

electrical signals with A/D and/or DIO boards plugged into a computer,

and possibly generating control signals with D/A and/or DIO boards in the

same computer
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device Instrument or controller that is addressable as a single entity and controls

or monitors real-world I/O points. A device is often connected to the host

computer through some type of communication network or can be a plug-in

device.

For data acquisition (DAQ) applications, a DAQ device is inside your

computer or attached directly to the parallel port of your computer. Plug-in

boards, PCMCIA cards, and devices such as the DAQPad-1200, which

connects to your computer’s parallel port, are all examples of DAQ devices.

SCXI modules are distinct from devices, with the exception of the

SCXI-1200, which is a hybrid.

DIO digital input/output

DRAM dynamic RAM

I

ISA industry standard architecture

L

LED Light-emitting diode.

R

resource locking a technique whereby a device is signaled not to use its local memory while

the memory is in use from the bus

T

TCP/IP Transmission Control Protocol/Internet Protocol

trigger any event that causes or starts some form of data capture
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V

VISA virtual instrument software architecture—a new driver software

architecture developed by National Instruments to unify

instrumentation software GPIB, DAQ, and VXI. It has been accepted

as a standard for VXI by the VXIplug&play Systems Alliance.
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documentation
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devices and corresponding manual

(table), 1-2

related documentation, x

downloading VIs, 4-1 to 4-2

E
embedded applications, 4-2

environment specifications, A-2

executables. See stand-alone executables,

creating.

H
hardware overview, 3-1 to 3-5

daughterboard, 3-4

host-to-RT Series DAQ device

communication, 3-4

LEDs, 3-5

PCI RT Series RT DAQ hardware

(figure), 3-1

processor board, 3-2 to 3-3

PXI RT Series RT DAQ hardware

(figure), 3-2

RTSI bus, 3-4 to 3-5

host-embedded communication shared

memory, A-1

host-to-RT Series DAQ device

communication, 3-4

I
installation, 2-1 to 2-2

PCI devices, 2-1 to 2-2

PXI devices, 2-2

software installation (note), 2-1

unpacking RT Series DAQ devices, 1-3

L
LabVIEW functions not supported on DAQ

hardware, 4-3
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LabVIEW RT programming, 4-1 to 4-5

creating stand-alone executables,

4-2 to 4-3

downloading VIs, 4-1 to 4-2

LabVIEW functions not supported on

DAQ hardware, 4-3

real-time programming, 4-4 to 4-5

configuration issues, 4-4 to 4-5

running VI at time-critical

priority, 4-4

shared memory, 4-4

resetting RT Series DAQ device, 4-2

RT Series DAQ VIs, 4-5

targeting LabVIEW RT, 4-1 to 4-2

LabVIEW RT software

board configuration, 2-2 to 2-4

installing NI-DAQ, 1-3

LEDs, 3-5

M
manual. See documentation.

Measurement & Automation

Explorer, 2-2 to 2-4

N
NI Developer Zone, B-1

NI-DAQ software, 1-3

P
PCI devices. See also hardware overview.

installation, 2-1 to 2-2

PCI RT Series RT DAQ hardware

(figure), 3-1

physical specifications, A-2

power requirement specifications, A-2

processor board, 3-2 to 3-3

board diagram, 3-3

description, 3-2

specifications, A-1

programming. See LabVIEW RT

programming.

PXI devices. See also hardware overview.

installation, 2-2

PXI RT Series RT DAQ hardware

(figure), 3-2

R
real-time programming, 4-4 to 4-5

configuration issues, 4-4 to 4-5

running VI at time-critical priority

without RT Development System, 4-4

shared memory, 4-4

requirements for getting started, 1-2

resetting RT Series DAQ device, 4-2

RT Series DAQ devices. See also hardware

overview.

configuration, 2-2 to 2-4

device number, 2-3

devices and corresponding manual

(table), 1-2

installation, 2-1 to 2-2

overview, 1-1

programming. See LabVIEW RT

programming.

requirements for getting started, 1-2

software programming choices, 1-3

specifications, A-1 to A-2

unpacking, 1-3

RT Series DAQ VIs, 4-5

RTSI bus, 3-4 to 3-5
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S
shared memory

host-embedded communication shared

memory, A-1

real-time programming, 4-4

software programming choices, 1-3

specifications, A-1 to A-2

stand-alone executables, creating, 4-2 to 4-3

command-line arguments, 4-2 to 4-3

embedded applications, 4-2

system integration, by National

Instruments, B-1

T
targeting LabVIEW RT, 4-1 to 4-2

technical support resources, B-1 to B-2

U
unpacking RT Series DAQ devices, 1-3

V
VIs

downloading VIs, 4-1 to 4-2

RT Series DAQ VIs, 4-5

W
Web support from National Instruments, B-1

Worldwide technical support, B-2


	RT Series DAQ Device User Manual
	Support
	Worldwide Technical Support and Product Information
	National Instruments Corporate Headquarters
	Worldwide Offices

	Important Information
	Warranty
	Copyright
	Trademarks
	WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

	Compliance
	Contents
	About This Manual
	Conventions
	Related Documentation

	Chapter 1 Introduction
	About the RT Series
	Table 1-1. RT Series DAQ Device and Corresponding DAQ Device Manual 

	What You Need to Get Started
	Unpacking
	Software Programming Choices

	Chapter 2 Installation and Configuration
	Installing the Hardware
	PCI Installation
	PXI Installation

	Board Configuration
	Figure 2-1. Measurement & Automation Explorer


	Chapter 3 Hardware Overview
	Figure 3-1. PCI RT Series Data Acquisition Hardware
	Figure 3-2. PXI RT Series Data Acquisition Hardware
	Processor Board
	Figure 3-3. RT Series Processor Board Diagram

	DAQ Daughterboard
	Host to RT Series DAQ Device Communication
	RTSI
	LEDs

	Chpter 4 LabVIEW RT Programming
	Targeting LabVIEW RT and Downloading VIs
	Figure 4-1. Select Target Platform Dialog Box
	Resetting the RT Series DAQ Device

	Creating Stand-Alone Executables
	Embedded Applications
	Command-Line Arguments

	Programming LabVIEW RT
	Real-Time Programming
	Running a VI at Time-Critical Priority without the�RT�Development�System
	Use of Shared Memory
	Configuration Issues

	RT Series DAQ VIs

	Appendix A Specifications
	Appendix B Technical Support Resources
	Glossary
	B-D
	I-T
	V

	Index
	B-L
	M-R
	S-W


